Experiment 27. Fourier Optics

1 Objectives

In geometrical optics, image formation is described with the use of so called “light rays”. This experiment introduces the theory of image formation when light is considered to be a wave. You will become familiar with Abbe’s theory of image formation. Patterns produced in the focal plane of a lens, from coherent light being diffracted by different objects, will be observed. Additionally, we will use simple spatial filtering in the focal plane and observe its influence on the image. Also you will become familiar with Fourier methods regarding the spatial filtering of an image by means of a computer program.

2 Introduction

The quality of the image produced by an optical system is influenced by aberrations in the components of the system and also by diffraction effects. Whether the light is coherent or
non-coherent is also important since the diffraction effects for coherent light are not the same as for non-coherent light. This was realized by the physicist Abbe in the latter part of the last century. He developed a theory of image formation with coherent illumination. This was of great importance in the development of high power microscopes. The ideas in the theory have also led to developments in major areas of modern optics. Though he did not express things in this way his theory implies that image formation is intimately related to the spatial frequencies present in the object. The passage or otherwise through the optical system of these spatial frequencies determines not only its resolution but affects the image sharpness. The failure to pass certain spatial frequencies can result in a false structure (i.e. false detail can appear). The deliberate suppression of certain spatial frequencies is known as spatial filtering and is of major importance in areas of modern optics such as confocal microscopy and image enhancement. This experiment deals with these ideas. Though the resolution of an optical system is important in determining the quality of the system, (and indeed until recent times was the only way), it is not the whole story. In terms of spatial frequencies, the resolution limit is the high spatial frequency cut-off. It says nothing about how the lower spatial frequencies are passed by the system. A complete description of the performance of the system is to specify its performance as a function of spatial frequency. This information is given by the so-called optical transfer function. In its most general form this function contains the effects of aberrations as well as diffraction. Since the diffraction effects are different, the function for coherent light is different from that for non-coherent light.

2.1 Abbe’s theory of image formation

With non-coherent light, the resolution of an optical system is determined by diffraction effects at the aperture of the system. The essence of Abbe’s theory is that, when one is treating an object illuminated by coherent light, it is necessary to consider the diffraction of the light by the object as well as by the subsequent aperture. The ideas are most easily explained by considering a one dimensional grating like the object in Fig. 27-1.

The incoming light is diffracted by the object (grating) and this diffracted light is then refracted by the lens to form the grating’s Fraunhofer diffraction pattern on the focal plane of the lens. The light continues on past this plane to form the image of the grating on the screen.

A very important and remarkable thing that can be shown is that the lens acts as a Fourier transformer in that the diffraction pattern on the focal plane is the Fourier transform of the object. This means that the diffraction pattern is the spatial frequency spectrum of the object just as the Fourier transform of a function in time is its frequency spectrum. For the simple one-dimensional grating, this means that the point $S_0$ is the “dc” component corresponding to zero spatial frequency, which arises because the light intensity cannot be negative. The points $S_1$ and $S'_1$ correspond to the fundamental spatial frequency present in the object, and the subsequent points represented by $S_2$ and $S'_2$ (that would be present in Fig. 27-1 if the wave paths $A_2$ and $B_2$ could go through the lens) etc, further out, correspond to harmonics of this fundamental frequency at higher and higher spatial frequencies.

Not only is the diffraction pattern the Fourier transform of the object but the inverse Fourier transform of the diffraction pattern is the image. The importance of the Abbe theory is now clearly evident. Any modification of the diffraction pattern will change the image to some extent. We thus have spatial filtering and the possibility of the introduction of false structure. We see also that every lens must act as a low pass filter since to pass all orders of the light...
Fig. 27-1 One dimensional grating image formation in coherent light. The coherent light is monochromatic and colours are used only for clarity. The wave path length difference between \( A_0 \) and \( B_0 \) is 0 and they converge at point \( S_0 \). The wave path length difference between \( A_1 \) and \( B_1 \) is \( \lambda \) (light wavelength) and they interfere constructively at point \( S_1 \). The wave path length difference between \( A_2 \) and \( B_2 \) is \( 2\lambda \) and they can interfere constructively but cannot converge because they are not going through the lens aperture. At the image plane (screen), the optical length of wave paths \( A_1, A_0 \) and \( A'_1 \) are all equal. They interfere constructively at point \( A_i \) even if the object is illuminated by non-coherent and non-monochromatic light.

diffracted by the object the lens would have to have an infinite aperture. The loss in high frequency information leads to a loss in the sharpness of the image. Finally there is the limit in the resolution of the system. For the image to be resolved it is clearly necessary that the first principal maxima, \( S_1 \) and \( S'_1 \) of the diffraction pattern, be passed by the aperture since these correspond to the fundamental spatial frequency. This is the condition which replaces the Rayleigh condition for non-coherent light. In general, of course, the object is not just a one-dimensional grating. For a general two-dimensional object, all the above ideas still apply (one can imagine the object to be a series of gratings of different spacing set at various angles to one another). The diffraction by the object is now not as simple but, notwithstanding this, a two-dimensional diffraction pattern is produced on the focal plane of the lens, a pattern which is the two-dimensional Fourier transform of the object and hence its spatial frequency spectrum.

2.2 Apparatus

The apparatus consists essentially of an optical bench with various mounts used to support the different components of the optical system. Fig. 27-2 shows the set-up which is used for the majority of the investigations.

Fig. 27-2 Experimental arrangement for examination of optical images. Some important components such as laser power supply and computer were omitted for clarity.
In turn, the items of the system are as follows:

1. Laser: this is a 1mW diode laser ($\lambda = 635$ nm) and is used as the coherent light source for the system. The height of the laser can be adjusted. The laser beam should already be adjusted so as to be parallel to the optical bench. The laser beam is expanded by the built-in beam expander. The beam expander should produce a beam so that its cross-section does not change along the optical bench. Care should be taken while using the laser. DO NOT ALLOW THE LASER BEAM TO ENTER YOUR EYE.

2. Laser current regulator: the laser beam intensity can be adjusted by changing the electric current supplying the laser diode. Additionally, use the adjustable neutral density filter if the beam intensity is still too high.

3. Adjustable neutral density filter: if the images observed are too bright the intensity of the beam should be decreased. This is achieved by rotating a neutral density filter in the mount next to the laser. IT IS VERY IMPORTANT TO KEEP THE INTENSITY OF THE LASER BEAM LOW TO AVOID SATURATION OR DAMAGE TO THE CCD CAMERA.

4. Object: for most investigations, the object illuminated is a vertical line grating (one-dimensional object) or a mesh (two-dimensional object). Other objects are used, however. One side of the frame of each object is painted black to avoid reflection of the room lights. Keep this side facing the CCD camera to increase the contrast in the images.

5. Lens: the lens used when working with the CCD camera has a focal length of approximately 31 cm. For the direct observation of the interference pattern on the screen, a lens with a 2 m focal length is provided.

6. Spatial filter: a variety of spatial filters are available for modifying the diffraction pattern in the focal plane of the lens. These consist of an adjustable slit, a black point, a black line, a periodic filter and a pinhole. The pattern at the focal plane is viewed using a magnifying glass.

7. Screen: the image is either formed on the chip of a CCD camera or a white card mounted at the end of the table in the line of the laser beam.

8. CCD camera: A CCD camera may be used to capture the image. The camera is mounted on an adjustable stand so that its position can be adjusted to observe various parts of the image. The camera can be temporarily removed away from the laser beam with ease, when doing direct observations on the screen, by using a hinge mechanism.

9. Computer with associated software: A computer is used for observing and analysing the image captured by the CCD camera. The program used to view or capture images is called “Camera”. Captured images can be then analysed using the “Scion Image” program.

3 Grating diffraction pattern

The object to be used in this investigation is the vertical line grating (called “1D grating”) supplied. Here we examine the details of its diffraction pattern.
1. If the CCD camera at the end of the optical bench is facing the laser beam rotate it on the hinge so that it is out of the path of the beam.

2. Using the “White Screen” placed in the “Object Mount”, observe the laser beam profile while moving the screen from the laser to the end of the optical bench. The laser beam should be parallel to the optical bench and should not change its profile (with the exception that the edges of the beam become softer when moving away from the laser due to diffraction on the aperture of the beam expander lens). If this test failed, notify your demonstrator. The height of the laser, the CCD camera, the object mount and the lens mount are preadjusted in such a way that the centres of all items lie on the main optical axis and should not be changed unnecessarily.

3. Place the “1D grating” in its mount, next to the beam expander.

4. Place the “f = 2 m” lens next to the “1D grating”. You should see a well focused diffraction pattern on the paper screen (which is placed approximately 2 m from the lens).

5. Observe the diffraction pattern on the paper. Measure the separation, \( x \), of the maxima, the so called orders of the diffraction pattern. Determine from this the separation, \( d \), between the slit’s centres in the grating and its associated error. Use the formula which gives the angular positions, \( \Theta \), of the different orders, \( n \), viz:

\[
d \sin \Theta = n\lambda \quad \text{where} \quad n = 0, 1, 2, 3 \ldots
\]  

(1)

where \( \lambda \) is the wavelength of the light (635 nm). Since \( \Theta \) is small, this becomes

\[
d = \frac{n\lambda D}{x} \quad \text{where} \quad n = 0, 1, 2, 3 \ldots
\]  

(2)

where \( D \) is the distance from the lens to the diffraction pattern. Measure \( D \) using the tape measure supplied.

You will notice that a few of the maxima are either missing or weak. An order is missing if an interference maximum, determined by the above equation, occurs at the same place as a minimum of the diffraction pattern determined by the width of the slits. If the slit width is \( a \), these diffraction minima occur at angles \( \Theta \) given by

\[
a \sin \Theta = m\lambda \quad \text{where} \quad m = 1, 2, 3 \ldots
\]  

(3)

From (1) and (3) there is a conjunction between the diffraction minima and interference maxima, hence, when

\[
\frac{d}{a} = \frac{n}{m}
\]  

(4)

Thus, for orders to be completely missing, \( d/a \) has to be an integer, since \( n \) and \( m \) are integers. If \( d/a = 5 \), for example, this equation shows the 5th \((n = 5, m = 1)\), 10th \((n = 10, m = 2)\), 15th \((n = 15, m = 3)\), etc., orders are missing. If \( d/a \) is not exactly an integer some orders will be weaker rather than missing.

6. Estimate the first missing order (with its associated error) and hence obtain an estimate for the slit width \( a \).

7. Measure the slit width, \( a \), and the separation of the centres of the slits, \( d \), using the travelling microscope. Compare these values with those obtained from the diffraction pattern.
Question 1: Make a prediction of how the diffraction pattern will look if you replace the “1D grating” with a single slit of width $a$.

Question 2: Check your prediction experimentally. Comment on the results.

Now we will investigate the diffraction pattern of the vertical grating in the focal plane of the lens using the CCD camera and the “Camera” program installed on the computer.

Note that you must print images of all the major results throughout this experiment and stick them in your logbook. To save your image you have to select an interesting part of it or a whole image and then use File→Save selection. To make a selection use Selection→Select all or Selection→Select for FFT or just drag the cursor across the image with the left mouse button pressed. The saved image can be opened in other programs such as “Scion Image” or “MS Word” to be printed or processed. The recommended method of printing images is to collect some of them in one folder and then use File→Print from the “Windows Explorer” window. This allows you to print a few images on one page.

8. Reduce the light intensity to its minimum using the laser current regulator and the adjustable neutral density filter.

9. Place the “$f = 31$ cm” lens on the optical bench in between the grating and the CCD camera approximately 31 cm from the camera.

10. Rotate the camera on the hinge to face the laser light.

11. Run the “Camera” program. Now you should see the diffraction pattern of the grating formed by the lens in its focal plane.

12. Move the lens gradually forward and backward until you create a sharp image of the diffraction pattern.

13. The X and Y position of the mouse pointer and intensity of the image at this point can be read in the “Info” window (View→Info). You can move the CCD camera transversally to the optical bench very precisely using a micrometric screw. Use this to calibrate your image by finding the size of 1 pixel. This will speed up your next measurements. To improve the visibility of the image, select an interesting part of it by dragging the mouse pointer across with the left mouse button pressed. Try also View→Profile to boost your productivity.

14. Repeat the measurement of the slit width, $a$, and the separation of the slits, $d$, that you did previously on the paper screen, this time using the CCD camera. The camera is mounted so, that its CCD sensor is at the beginning of the optical bench scale. Measure the distance between the lens and the CCD sensor and use it as the value for $D$. This is also the focal length $f$ of the lens.

15. Change the position of the object by moving it along the optical bench between the lens and the laser. What changes in the diffraction pattern do you observe? If you can’t see any changes, move the camera transversally and increase the intensity of the laser beam to see just some of the higher order maxima.

16. Replace the “1D grating” with the “2D grating Fine” and observe its diffraction pattern.
17. Replace the “2D grating Fine” with the “2D grating Coarse” and observe its diffraction pattern.

**Question 3:** Why should we use the distance between the camera and the lens as the value for \( D \) rather than the distance between the camera and the diffraction grating?

**Question 4:** Comment on differences between the diffraction patterns of the “2D grating Fine” and “2D grating Coarse” objects.

### 4 Image formation with coherent light

In this section, we look at the images of objects illuminated by coherent light and see how these images are modified by spatial filtering in the focal plane of the lens used to form the image. The set-up for these investigations is as shown in figure Fig. 27-2.

#### 4.1 Image of a one-dimensional grating

An image of the object is formed using the lens provided. The image should be observed using the CCD camera.

1. Using the focal length of the lens measured earlier calculate the position of the lens and the object to achieve an image magnification of 0.5. Hint: Use the thin lens equations:

\[
\frac{1}{f} = \frac{1}{s_o} + \frac{1}{s_i} \quad m = \frac{s_i}{s_o}
\]

where:
- \( f \) is the focal length of the lens
- \( s_o \) is the distance between the object and the lens
- \( s_i \) is the distance between the lens and the image
- \( m \) is the image magnification

2. Move the lens and the object to that position.

3. Finely adjust the position of the lens so that as to have the image is in focus.

4. Note the image and its main features.

5. From the object, lens and image positions, determine the focal length of the lens exactly.

#### 4.2 Spatial filtering

1. Place the spatial filter mount at the focal point of the lens, so that a white card held in it is at the focal plane of the lens. View the pattern on the screen and check, approximately, that it is the same as the diffraction pattern observed in section 3.
2. If necessary adjust the lens position until the image is sharp and clear.

3. From the “Selection” menu of the “Camera” program choose “Select for FFT”. This will select a central region of the image for which the horizontal and vertical size in pixels is a power of 2. This is necessary because the “Scion Image” program will use the so called Fast Fourier Transform (FFT) algorithm designed for such images.

4. When you are happy with the quality of the image, save the selection to a file (in “BMP” format). This file will be used in later stages of the experiment.

5. Examine the effect of spatial filtering in the focal plane on the image. You should try removing different spatial frequencies using the masks provided. In this context, at least the following four cases should be tried:
   
   (a) Pass only the central frequency (mask the rest).
   (b) Pass the central and two side band frequencies closest to it.
   (c) Pass high frequencies only (cut out the 0 order frequency).
   (d) Pass high frequencies, one side only.

6. Record your observations and give an explanation for all of the observed effects.

You should be looking for not only gross changes to the image, that is the introduction of false structure, but other effects such as a decrease in the sharpness of the image and changes in the relative brightness of the bright and dark parts of the image.

4.3 Computerised image analysis

1. Now close the “Camera” program and run the “Scion Image” software.

2. Load the file that you have saved earlier. Perform a FFT on the image (Process $\rightarrow$ FFT $\rightarrow$ FFT). This will result in a diffraction pattern (in a new window) observed in the focal plane of the lens. The program assigns black colour to the highest values of the spectrum, so the image of the FFT will be the inverted image of what you observe at the focal plane of the lens. To rectify this (if you wish to do so) choose Edit $\rightarrow$ Invert menu.

3. Perform an inverse FFT on the FFT window. The result that will appear on a new window should be the same as the original image.

4. Now close all windows except the main image window. Produce again a FFT of this image.

At this stage we would like to remove some of the spatial frequencies from the diffraction pattern and examine its effects on the final image. To do so we will paint a mask on the FFT window. This can be done by painting with the brush or by selecting a shape like a rectangle or ellipse and filling the selection using Edit $\rightarrow$ Fill menu (Ctrl+F). Black areas will pass the corresponding frequencies and white areas will filter out the corresponding frequencies. It is not, however, possible to do both: to pass and to filter out during the same inverse transform.

5. This time repeat procedures 1 to 4 given in section 4.2 on the saved image using the FFT software and compare the results with real filtering in the focal plane.
4.4 Image of a two-dimensional grating

1. Now close the “Scion Image” software and run the “Camera” program.

2. Use a slightly dusty fine mesh object. Observe its Fourier transform in the focal plane of the lens. Try to filter its image to have just the dust visible. Use the “Pinhole filter” to pass just a central bright spot with some surrounding.

3. Use the “Periodic filter” to pass just the centres of the bright spots of the diffraction pattern. You should observe a very clean image of the mesh, but without dust.

4. Remove the filter and select part of the image for FFT. Save it to the file.

5. Open the saved file in the “Scion Image” and repeat all the spatial filtering you did above using digital processing.

**Question 5:** Summarise and explain the results that you observed in the experiments that you carried out in sections 4.1, 4.2, 4.3 and 4.4.

**Question 6:** Do you expect the spatial filtering to be so effective if we use a white light source rather than the laser? Why?

4.5 Image of phase objects (Optional)

The objects examined so far are what are known as *amplitude objects*. These are observable because of the variations they cause in the amplitude of the light waves. In contradiction to these are *phase objects*, which are transparent, thereby providing no contrast with their surroundings, but which alter the phase of the waves. The optical thickness of such objects varies from point to point as either the refractive index or actual thickness, or both, vary.

Biological specimens are often of this nature. Various techniques have been developed to render such objects visible. All these techniques convert phase variations into amplitude variations which are visible. All of these (apart from staining which has its drawbacks), rely on spatial filtering in the focal plane of a lens. The best of these is the phase contrast method, used in phase contrast microscopes, which makes use of a $\pi/2$ phase shifting filter.

Good results, however, can be obtained by just removing a certain frequency in the diffraction pattern.

In the *Dark Field* technique, the central maximum is removed. This central maximum represents the incoming beam unperturbed by the object. If this is removed, we are simply left with the diffusive contribution of the object.

In the *Schlieren Technique* all maxima on one side of the pattern (and the central maximum) are removed.[1]

A close approximation to a true phase object would be the heated air above a hot wire. This should be investigated.

[1] For further information see [1], section 13.2.
1. Place the wire heater in the object’s mount. Using the computer display, observe the image of the wire. Adjust the wire so that only its top is visible (the wire should be placed along the laser beam). Switch on a current to heat the wire. Investigate the effect on this image by using the Schlieren technique of masking in the focal plane of the lens. Comment on your results.

**Question 7:** Why won’t we get the same result if we artificially remove the frequency components within the computer?

**References**

